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PREDGOVOR

Reprofotografija je deo tehnološkog procesa reprodukcije originala koji se 
zasniva na fotografskim postupcima i procesima. Obuhvata pravilno snimanje 
odnosno uzorkovanje originala i njegovu odgovarajuću pripremu za neku od 
tehnika štampe. Naglim razvojem računarskih tehnologija i širenjem stonog 
izdavaštva, skoro svi koraci u reprofotografiji su se digitalizovali. Snimanje 
digitalnim fotoaparatima i skeniranje, kao i obrada uzorkovanih fotografija 
se danas u potpunosti radi pomoću računara i naprednih računarskih 
programa.

Adobe Photoshop, kao najpoznatiji i najkorišćeniji programski alat u 
digitalnoj reprofotografiji, u potpunosti omogućava sve neophodne ispravke, 
i unapređivanja digitalnih slika radi što bolje i vernije reprodukcije. Za 
pravilan rad u ovakvom složenom programskom alatu, potrebno je znanje 
iz klasične reprofotografije kao i iz savremenih digitalnih tehnologija. 
Iako postoje prevođena dela stranih autora o radu u Adobe Photoshopu, ti 
materijali uglavnom predstavljalju uopšteni prilaz programskom alatu.

Ovaj priručnik je pokušaj unapređivanja postojećeg stanja pošto sadrži 
fundamentalne koncepte i tehnike, kao i napredne tehnike rada za ispravljanje 
i pripremanje slika za reprodukciju u štampi. Priručnik je namenjen 
studentima Departmana za grafičko inženjerstvo i dizajn Fakulteta tehničkih 
nauka u Novom Sadu, ali i inženjerima i tehničarima pripreme štampe, kao 
i svim zainteresovanima za obradu digitalnih fotografija. Tekst je pisan za 
napredne korisnike Photoshopa CS5 (mada su mnoge tehnike primenjive 
i u drugim verzijama programa), i podrazumeva prethodno poznavanje 
alata i programskog okruženja. Sa druge strane sve tehnike i strategije za 
popravljanje i pripremu fotografije su potkrepljene teorijskim materijalima 
koji omogućavaju dubinsko razumevanje svakog koraka i daju korisno znanje 
za obradu svih vrsta slika.

Materijal je organizovan u šest celina koje obuhvataju: ispravljanje i 
prilagođavanje tonova i kontrasta, rad sa bojama, rad sa maskama, uklanjanje 
šuma i izoštravanje, retuširanje kao i pripremu štampe digitalnih slika.

Na početku svake vežbe je dat cilj vežbe, i kratak teorijski uvod sa strategijama 
i tehnikama za rešavanje specifičnih problema. Posle uvoda su predstavljene 
detaljne tehnike kroz razrađene primere i korisne savete koji su upotrebljivi 
prilikom obrade fotografija. 



U okviru teksta, radi lakšeg pregleda i savladavanja predstavljenog materijala, 
nalaze se tri simbola:

Označava dodatne informacije za određenu oblast ili alatku. Ove 
informacije najčešće proširuju osnovni tekst i daju dublji pregled 
određene alatke ili tehnike.

Označava brze kartice. Sve tehnike obrade slika su detaljno 
opisane u okviru urađenog primera, dok ove kartice na kraju 
primera sadrže taksativno nabrojane sve korake za određenu 
operaciju i služe za brzo podsećanje.

Označava konačne napomene koje se nalaze na kraju svake 
vežbe i predstavljaju uopštene zaključke i važne napomene za 
problematiku obrađenu u okviru svakog poglavlja.

Na kraju vežbi su dati zadaci u obliku dodatnih slika za vežbanje, koje 
metodološki omogućujavaju proveru i vežbanje predstavljenih načina 
rešavanja problema u digitalnoj reprofotografiji. Sve slike iz priručnika se 
mogu preuzeti na stranici predmeta Reprodukciona tehnika na internet 
adresi www.grid.uns.ac.rs.

Fotografije koje su sadržane u ovom izdanju su većinom preuzete sa internet 
stranice www.sxc.hu i digitalne biblioteke američkog Kongresa i pripadaju 
njihovim autorima. Navedene slike su iskorišćene isključivo u edukativne 
svrhe, u skladu sa pravilima i uslovima Internet stranice www.sxc.hu. 

Slike koje nisu preuzete sa navedenih Internet stranica isključivo su 
vlasništvo autora ovog izdanja, predstavljaju njihovo autorsko delo i kao 
takve, obuhvaćene su autorskopravnom zaštitom u skladu sa Zakonom 
o autorskom i srodnim pravima („Sl. glasnik RS“ br. 99/2011) i drugim 
pozitivnim propisima koji regulišu ovu materiju.

Novi Sad, 2012.                Autori
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Cilj vežbe je upoznavanje osnovnih pojmova vezanih za korekciju tonova, 
kontrasta i ekspozicije i tehnika za poboljšanje detalja na slici u cilju verne i 
kvalitetne reprodukcije.

U okviru vežbe će se obraditi:
Koncept tonova i kontrasta i strategije ispravki ■
Histogrami i njihove procene ■
Rad sa alatkama  ■ Nivoi (Levels) i Krive (Curves), Ekspozicija 

(Exposure)
Korišćenje slojeva za podešavanje za korekciju tonova ■
Globalne i lokalne promene slike za ispravljanje kontrasta i  ■

ekspozicija

1.1. Definisanje pojmova ton i kontrast

Važna karakteristika svake slike je njen tonski opseg odnosno raspon 
svetlosnih informacija koje formiraju elemente na slici. Tonske vrednosti se 
najčešće dele u tri grupe: na tamne tonove (engl. shadows), srednje tonove 
(engl. midtones) i na svetle tonove (engl. highlights). Primer rasporeda 
tonova je prikazan na slici 1.1.

VEŽBA BR. 1
Korekcija tonova, kontrasta i                                
grešaka ekspozicije

Slika 1.1. Tonske vrednosti na digitalnoj slici
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Svaka od tih glavnih grupa u sebi sadrži niz tonskih nivoa čije pravilno 
upravljanje osigurava kvalitetnu reprodukciju. Kod crnobelih fotografija, kao 
i reprodukcionih filmova za izradu štamparskih formi, tonove su formirali 
kristali srebrohalogenida gde je količina srebrohalogenida uticala na količinu 
propuštene odnosno reflektovane svetlosti i time određivala svetlinu nekog 
elementa na slici. Promena svetline tih elemenata se rešavala promenom tipa 
filma, menjanjem intenziteta i vremena osvetljavanja, čime je kontrolisana 
količina svetla koja pada na površine osetljive na svetlo.

Kontrola tonova u reprodukciji filmova se najčešće vrši pomoću denzitometara 
kojima se određuje optička gustina tonskog polja. Vrednosti tonova se mogu 
izraziti i preko integralne optičke gustine kroz vrednosti tonske pokrivenosti. 
Raspored svetlosnih informacija fotografije kojima odgovaraju različite 
vrednosti tonske pokrivenosti se mogu predstaviti na nekoliko načina. Kod 
digitalnih fotografija se prikaz raspodele tonskog opsega prikazuje u obliku 
histograma, a kod osvetljavanja i reprodukcije u grafičkoj industriji preko 
tonske skale od 0 do 100% tonske pokrivenosti. Postoji još i zonski sistem 
razvijen od strane poznatog fotografa Ansel Adamsa gde je definisano 11 
zona (od apsolutne bele do apsolutne crne), koji je koristan za brzu vizuelnu 
procenu rasporeda tonova unutar dinamičkog opsega slike.

Slika 1.2. Histogram i zone Ansel Adamsa

Sa druge strane kontrast je razlika između tonskih vrednosti susednih 
površina. Što je veća ta razlika, veći je i kontrast. Pravilno određivanje 
kontrasta je važno jer nedostatak kontrasta negativno utiče na izgled slike 
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Za uređivanje tonova i kontrasta kao i drugih ispravki na digitalnim 
fotografijama, važno je koristiti načine koji ne oštećuju izvornu digitalnu 
sliku i smanjiti broj koraka koji mogu da promene dobre vrednosti izvorne 
slike. Tri glavne strategije za rad sa slikama gde želimo izbeći oštećenja su:

Rad sa slikama sa više bitova zbog povećanog tonskog opsega ■
Korišćenje slojeva za podešavanje (Adjustment Layers) u  ■

Photoshopu 
Primena globalnih ispravki i poboljšanja na sirovoj (engl. raw)  ■

slici

1.2. Rad sa histogramima

Histogram u programima za uređivanje slike služi za prikaz distribucije 
svetline svih piksela na slici. Ukoliko se radi o slici od 8 bita, histogram će 
sadržati numerički prikaz intenziteta svetline piksela u opsegu od 0 do 255 
što čini 256 nivoa. Što je više piksela sa određenim intenzitetom na određenoj 
tonskoj vrednosti, to će na histogramu odziv biti viši.

Photoshop ima mogućnost prikaza tri vrste histograma. Kompozitni RGB u 
kojem se daje zajednički zbir svih piksela svih kanala (crveni, zeleni, plavi). 
Histogram svetline koji je sličan kompozitnom, ali koji dodatno uzima u 
obzir i osetljivost ljudskog oka na zelenu, crvenu i plavu boju što je definisano 

Slika 1.3. Primeri (a) slabog, (c) dobrog i (c) prejakog kontrasta

i može da utiče na nedovoljno isticanje važnih detalja. Kontrast varira u 
zavisnosti od sadržaja slike, postojećeg kontrasta između pojedinačnih 
elemenata, ograničenja izlaznog uređaja i ličnog osećaja osobe koja uređuje 
fotografiju. Primeri slike slabog, optimalnog i jakog kontrasta su prikazane 
na slici 1.3.
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Slika 1.4. Histogrami i problemi

Verovatno podeksponirana slika ili 
tamni subjekat (tonovi su uglavnom 
preraspoređeni u izrazito tamnim i 
delimično u sređnjim tonovima).

Pravilna ekspozicija, gde ravnomeran 
histogram predstavlja sliku sa punim 
tonskim opsegom. Ovu sliku je lako 
uređivati i prilagođavati.

Verovatno preeksponirana slika ili 
svetli subjekat (tonovi su uglavnom 
preraspoređeni u izrazito svetlim 
tonovima i delimično u srednjim).

Histogram slike koja je “ravna” odnosno 
ima mali kontrast (ili slika snimljena 
u magli) bez izrazito tamnih i svetlih 
tonova.

Histogram u obliku izdvojenih linija 
odnosno izdvojenih tonova ukazuje na 
sliku koja je posterizovana. Najčešće se 
javlja prilikom prevelikog uređivanja 
slika sa ograničenim tonskim ospegom. 

čepićima i štapićima u mrežnjači ljudskog oka. Ovaj tip histograma daje 
najbolje grafičko predstavljanje vizuelne svetline i kontrasta slike. Treći tip 
histograma je u suštini prikaz histograma pojedinačnih kanala (na primer 
crveni, zeleni i plavi ako je slika u RGB modelu boja).

Kod uređivanja slike i korekcija tonova i kontrast histogram predstavlja važan 
pomoćni alat i zbog toga je važno pravilno proceniti preraspodelu svetline 
na slici. Histogram predstavlja snimak stanja na slici i ne postoji idealni oblik 
histograma (jer zavisi od elemenata na slici), ali postoje određene pojave 
koje veoma jasno ukazuju na određene probleme na digitalnim slikama 
kao što je podekspozicija, preekspozicija, nedovoljan kontrast, odsecanje 
određenih tonskih opsega  ili posterizacija. Na slici 1.4 su prikazani tipični 
oblici histograma i mogući problemi.
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Statističke vrednosti na histogramu:

U Photoshopu je moguće, putem statističkih vrednosti, brojčano odrediti vrednosti 
nivoa piksela raspoređenih na histogramu. Prikaz ovih vrednosti (Show Statistics u 
kartici Histogram) je moguće prilikom korišćenja proširenog prikaza histograma 
(Expanded), kao i prilikom prikaza svih kanala (All Channels View). Podaci za opeg 
tonskih vrednosti piksela ili specifičan nivo piksela se dobija pritiskom pokazivača 
na histogramu.

Statističke vrednosti obuhvataju:

Mean - Predstavlja srednju vrednost intenziteta piksela

Std Dev (Standard deviation) - Prikazuje opseg variranja intenziteta

Median - Srednja vrednost u opsegu vrednosti intenziteta piksela

Pixels - Prikazuje ukupan broj piksela koji je korišćen za proračun histograma.

Level  - Nivo intenziteta površine ispod pokazivača

Count - Ukupan broj piksela na nivou intenziteta ispod pokazivača

Percentile - Prikazuje kumulativan broj piksela na nivou gde je pokazivač. Ta 
vrednost je izražena kao procenat svih piksela na slici od 0% na krajnjoj levoj strani 
do 100% na krajnjoj desnoj strani.

Cache Level - Prikazuje trenutnu memoriju otvorene slike koja se koristi za prikaz 
histograma. Kada je vrednost veća od 1, histogram se brže prikazuje jer se koristi 
reprezentativno uzorkovanje piksela slike (u zavisnosti od uvećavanja). Izvorna 
slika ima nivo 1 dok se na svakom sledećem koristi 4 susedna piksela za brži 
proračun vrednosti.
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Ove alatke u kombinaciji sa dodatnim mogućnostima mogu da reše najveći 
deo problema sa tonovima na slici, i biće detaljnije obrađene kroz tipične 
primere. Dodatna alatka za ispravljanje nedostataka na slici koja će se 
obrađivati je alatka Senke/Svetli tonovi (Shadows/Highlights). 

Alatke iz panela za podešavanje se mogu koristiti kao slojevi za podešavanje 
(Adjustment Layers). Ova  metoda ne menja izvorne vrednosti na digitalnoj 
slici, i uz mogućnost maskiranja, promene providnosti i načina mešanja 
pruža bezbrojne načine za profesionalnu korekciju tonova i kontrasta.

Slika 1.5. (a) Slojevi za podešavanje i predefinisana podešavanja, 
(b) Isključena opcija Clipping Mask i (c) Uključena opcija Clipping Mask

1.3.  Korišćenje alatki za korekciju tonova i kontrasta u 
Photoshopu CS 5

Adobe Photoshop CS 5 sadrži nekoliko mogućnosti za korekciju ekspozicije, 
tonskog opsega i kontrasta koji se najčešće razlikuju u stepenu kontrole 
korisnika i mogućnošću izolovanja određenih tonskih opsega. 

Najčešće korišćenje alatke (slika 1.5) se nalaze u prvom redu panela za 
podešavanja (Adjustment panel) i to su: Svetlina/Kontrast (Brightness/
Contrast), Nivoi (Levels), Krive (Curves) i Ekspozicija (Exposure). 
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Slika 1.6.  Mogućnosti alatki za uređivanje tonova i kontrasta

Pored ručnih podešavanja svaka od ovih alatki ima i niz predefinisanih 
podešavanja za rešavanje određenih problema na slici (Posvetli, Potamni, 
Povećaj kontrast itd.). Treba napomenuti da alatka Svetlina/Kontrast 
(Brightness/Contrast) nije preporučljiva za profesionalni rad zbog manjka 
kontrole na tonskim opsezima koje imaju alatke Nivoi (Levels) i Krive 
(Curves).

Sa druge strane alatka Senke/Svetli Tonovi (Shadows/Highlights) radi direktno 
na slici i time gubi fleksibilnost gore pomenutih metoda korekcije i potrebno 
ju je pažljivo koristiti. Hijerarhija alatki za uređivanje tonova i kontrasta je 
prikazana na slici 1.6.
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Alatka sadrži i tri kapalice za dodeljivanje tačnih vrednosti za svetle, srednje 
i tamne tonove. Kod pomeranja klizača crne tačke prema desnoj strani dolazi 
do potamnjivanja slike (mapiranje nove crne tačke), dok pomeranje klizača 
bele tačke nalevo posvetljuje sliku (mapiranje nove bele tačke). 

Klizač za srednje tonove preraspodeljuje srednje tonove na slici, i pomeranjem 
ulevo će posvetliti sliku, a pomeranjem udesno će potamniti sliku. Pod 
mapiranjem nove bele i crne tačke se podrazumeva da će pomeranjem 
klizača za crnu tačku udesno (na primer ako je klizač na novoj poziciji na 

1.3.1. Alatka Levels

Alatci Nivoi (Levels) je moguće pristupiti putem meni linije 
(Image>Adjustment>Levels ili Ctrl+L) ili putem sloja za podešavanje (zbog 
zaštite izvornih piksela) pravljenjem novog sloja za podešavanje u meniju 
Slojevi (Layers). Alatku je moguće aktivirati i direktnim odabirom iz panela 
za podešavanje. Kod uređivanja crnobelih odnosno fotografija sa sivim 
tonovima ili za podešavanje opštih vrednosti slike, alatka Nivoi (Levels)
kontroliše tri aspekta slike: belu tačku, sive vrednosti i crnu tačku. 

Glavne kontrole su dva niza klizača Ulaznih i Izlaznih nivoa (Input/Output 
Levels). Raspored kontrola je prikazan na slici 1.7. 

Histogram

Crni klizač
(ulazni nivoi)

Beli klizač (ulazni nivoi)

Kapalice za 
dodeljivanje tačnih 

vrednosti za
svetle, srednje i
tamne tonove

Beli klizač
(izlazni nivoi)

Crni klizač
(izlazni nivoi)

Odabir kanala

Podešavanja za 
Auto opcije

Klizač za korekciju srednjih 
tonova (ulazni nivoi)

Slika 1.7. Radni prozor alatke Nivoi (Levels)
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nivou  50) svi pikseli koji se nalaze levo od klizača (pikseli na histogramu 
od 0 do 49) pretvoreni u potpuno crnu boju, odnosno smatraće se da imaju 
vrednost 0. Slično, kod klizača za belu tačku svi pikseli na nivoima desno od 
nove pozicije bele tačke (na primer 210) biće pretvoreni u apsolutno bele 
vrednosti (vrednost piksela od 255). Na ovim vrednostima nivoa piksela neće 
biti više detalja, nego će te vrednosti biti isključene iz tonskog opsega slike 
(engl. clipping). Klizač za srednje tonove ili gamma klizač određuje tačnu 
vrednost srednjih tonova (50% sive, nivo 128 ili zona V). 

Pomeranjem klizača za srednje tonove nalevo slika će se posvetliti, jer će 
se neki tamniji delovi fotografije (niže vrednosti nivoa) odrediti kao nove 
srednje vrednosti tona. Pomeranjem udesno slika će se potamniti jer slično 
kao u prethodnom slučaju vrednosti srednjih tonova se premeštaju na 
više vrednosti nivoa što dovodi do pomeranja svih srednjih tonova. Treba 
napomenuti da klizač za srednje tonove ne utične na crnu i belu tačku.

Klizači kod Izlaznih nivoa (Output Levels) rade na obrnutom principu gde 
pomeranjem klizača crne tačke posvetljujemo tamne tonove, a pomeranjem 
klizača bele tačke nalevo potamnjujemo svetle tonove. Ova opcija se koristi 
kod prilagođavanja tonskog opsega neke slike određenim tehnikama štampe 
sa ograničenim rasponom tonova. Na primer, ako se važne informacije 
nalaze u svetlim tonovima sa vrednošću intenziteta od 245, a štamparska 
mašina nije u stanju da odštampa tonske vrednosti manje od 5%, klizač za 
svetle tonove se može podesiti na vrednost 242 (5% tonske pokrivenosti na 
štamparskoj mašini) i time omogućiti nesmetano štampanje svetlih tonova 
bez njihovog odsecanja. Iako ova metoda omogućava posvetljivanje tamnih 
tonova i potamnjivanje svetlih tonova, ona ne omogućava vraćanje detalja 
koji nisu zapisani tokom digitalizacije slike.

Kod rada sa kapalicama je moguće dati specifičnu vrednost za belu i 
crnu tačku i primeniti ih na određenim segmentima slike (za koje su date 
minimalne i maksimalne vrednosti pokrivenosti tonova reprodukcije). Važno 
je napomenuti da su vrednosti kapalica programski automatski podešene na 
vrednosti 0 za crnu tačku i 255 za belu tačku, i ukoliko se žele primeniti za 
ispravku tonova, potrebno je da se ove vrednosti ručno podese (definisanjem 
vrednosti u uzorkivaču boja unutar Options pri čemu se bojama pristupa 
duplim klikom na Shadows ili Highlight). Kapalica za srednje tonove se koristi 
za neutralisanje narušenog sivog balansa kod slika u boji, a kod uređivanja 
slika sa sivim tonovima nije aktivna. 

Opisana procedura korekcije je prikazana na slici 1.8 koja predstavlja sliku 
sa niskim kontrastom gde su tonovi koncentrisani u srednjim tonovima bez 
izražene crne i bele tačke.



■ 20 

Slika 1.8. Podešavanje kontrasta upotrebom alatke Nivoi (Levels)

Kod pomeranja klizača na određeni nivo  ili definisanja regiona za kapalice 
je važno da se, ukoliko ne postoje tačno određene vrednosti, nađe najbolja 
kombinacija povećanja kontrasta sa najmanjim mogućim gubitkom 
međutonova. Pronalaženje granice gubitka tonova odnosno upotrebljivih 
najtamnijih i najsvetlijih tonova se postiže držanjem tastera Alt prilikom 
pomeranja klizača crne i bele tačke. 

Na slici 1.9  je prikazana primena ove opcije prilikom nepravilnog podešavanja 
klizača. Povlačenjem klizača za crnu tačku prema višim (svetlijim) 
vrednostima nivoa uz kontinualno držanje Alt komande, crnom bojom se 

1. Napraviti sloj za podešavanje Nivoi (Levels) u paleti 
Slojevi (Layers) (Adjustment Layer>Levels)

2. Povlačenjem crnog klizača nalevo premapirati    
crnu tačku

3. Povlačenjem belog klizača nadesno premapirati 
belu tačku

4. Povlačenjem sivog klizača podesiti srednje tonove

Na slici je urađeno premapiranje crne i bele tačke, kao i podešavanje sivih 
tonova. Pomeranjem klizača crne tačke je definisana nova crna tačka na 
nivou 36, a pomeranjem klizača bele tačke je definisana nova bela tačka na 
nivou 189. Radi postizanja još jačeg kontrasta, sivi tonovi su podešeni na 
vrednost 0.85. Na histogramu slike se vidi da sada slika sadrži širi tonski 
opseg sa delimičnim gubitkom nekih od nivoa, koji prilikom reprodukcije 
ovakvih slika ne bi trebalo da predstavljalju problem.
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Slika 1.9. Provera odsecanja tonova prilikom podešavanja nove crne tačke

Pomoću alatke Nivoi (Levels) korišćenjem klizača i kapalica korigovati 
sledeće fotografije koje su priložene uz priručnik:

1.3.2.  Alatka Curves

Alatka Krive (Curves) predstavlja najdetaljniji alat za korekciju tonova i 
kontrasta slike. Pomoću ove alatke moguce je izvesti sve korekcije urađene 
putem drugih alatki uz dodatnu kontrolu svakog tonskog opsega. Kod alatke 
Nivoi (Levels) postoje tri predefinisane tačke za izvođenje korekcije (crna, 
bela, siva), dok krive omogućavaju 16 kontrolnih tačaka za veoma precizno 
uređivanje tonova. Koncept krive koji povezuje dve različite veličine ima 

prikazuju površine koje će biti odsečene odnosno pretvorene u apsolutne 
crne tonove. Na prikazanom primeru svi tonovi koji se nalaze ispod nivoa 
74 će biti pretvoreni u najtamniji  ton pošto vrednost 74 predstavlja novu 
crnu tačku. Pomeranjem klizača za belu tačku pomoću istog principa se 
proveravaju moguća odsecanja tonova u svetlim tonovima.
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analogije sa nekoliko poznatih odnosa, kao na primer, odnos tonskih 
vrednosti na filmu odnosno štamparskoj formi i tonskim vrednostima na 
otisku, gde ucrtavanjem u koordinatni sistem dobijamo krivu zavisnosti koja 
se definiše kao kriva porasta tonskih vrednosti. Slika 1.10 prikazuje osnovni 
prozor kod rada sa krivima.

Osnovni prinicp rada sa krivom se zasniva na odnosu Ulaznih (Input) odnosno 
Izlaznih (Output) tonskih vrednosti koje definiše kriva. Ukoliko je linija 
pod uglom od 450 uspostavljen je linearni odnos ulaznih i izlaznih tonova 
(na primer 128 u digitalnim vrednostima ili 50% u tonskim vrednostima će 
biti vrednost i ulaznih i izlaznih tonova). Ukoliko linija odstupa od ravne, 
dobijamo krivu, čiji oblik definiše preraspodelu tonova između ulaznih i 
izlaznih vrednosti.

Važno je zapamtiti da što kriva ima veći nagib, to je i veći kontrast na slici što 
je analogija sa krivima reprodukcije filmova (tvrdi odnosno visokokontrastni 
filmovi i meki odnosno niskokontrastni filmovi). Svi delovi slike odnosno 
tonski opsezi koji su u delu krive sa oštrijim nagibom dobijaju na kontrastu, 
dok delovi koji se nalaze u ravnijim delovima sa manjim nagibom gube na 
razlici tonova odnosno gube vrednost kontrasta.

Slika 1.10. Radni prozor alatke Krive (Curves)

Histogram

Kapalice za 
dodeljivanje tačnih 

vrednosti za
svetle, srednje i
tamne tonove

Ulazna
vrednost

Izlazna
vrednost

Crtanje krive 
pomoću tačaka

Crtanje krive 
proizvoljno

Odabir kanala

Podešavanja za 
Auto opcije

Prikaz vrednosti na 
x i y osi na krivi

Auto krive
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Pre početka rada sa krivima je važno napomenuti da krive mogu 
prikazivati dve međuzavisnosti.

Prva međuzavisnost pokazuje ulazne i izlazne vrednosti svetline na 
skali od 0 do 255 nivoa što je predefinisani način rada kod fotografija 
u RGB modelu boja. 

Ova dva načina rada se razlikuju u rasporedima crne i bele tačke, gde 
kod međuodnosa svetline leva tačka na krivoj predstavlja crnu tačku, 
a desna tačka belu, a kod međuodnosa tonske pokrivenost je obrnuto. 
Određivanje načina rada se radi u podmeniju radnog prozora Krive 
(Curves) sa Opcijom za prikaz krive (Curves Display Option). Kod rada 
sa vrednostima svetline i skale od 255 nivoa povlačenjem krive nagore 
od prvobitne pozicije fotografija se posvetljuje (dodaje se svetlina, 
pojačava ekspozicija), dok se povlačenjem krive nadole fotografija 
potamnjuje (oduzima se svetlina, smanjuje se ekspozicija). Sa druge 
strane kod rada sa odnosom tonske pokrivenosti i skale od 100 tonskih 
vrednosti, povlačenjem krive nagore se slika potamnjuje (dodaje se 
boja na površinu), dok se povlačenjem krive nadole slika posvetljuje 
(oduzima se boja sa površine). Odabir metode zavisi od namene 
korekcije i od pripremljenosti korisnika. U priručniku za primere je 
korišćena kriva sa međuodnosom pokrivenosti površine bojom koja 
je namenjena fotografijama koje se pripremaju za štampu.

0

0

255

100

Drugi predstavlja odnos tonske pokrivenosti površine bojom na skali 
od 0 do 100% što je predefinisani način rada kod fotografija u CMYK 
modelu boja. 
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Slika 1.12. Analogija alatke Krive (Curves) sa alatkom Nivoi (Levels)

Pomoću alatke Krive (Curves) se mogu vršiti izmene kao i sa drugim 
alatima. Radi lakšeg praćenja prikazana je analogija sa alatkom Nivoi 
(Levels). Prilikom pomeranja krajnjih tačaka u ćoškovima u horizontalnom 
smeru  pomeramo crnu i belu tačku ulaznih vrednosti, a pomeranjem istih 
tačaka u vertikalnom smeru, radimo pomeranje izlaznih vrednosti kao što 
je prikazano na slici 1.12. Pomeranje središnje tačke na krivi je ekvivaletno 
pomeranju klizača za sive tonove u alatki Nivoi (Levels). 

Moguće je upotrebiti četiri različite metode kako bi se dobile iste vrednosti 
izlaznog tona, ali sa različitim oblicima krivih koje kao rezultat daju četiri 
različite slike. 

Na slici 1.11 je prikazan primer gde je tonska vrednost od 70% povećana na 
tonsku vrednost od 80% koristeći različite metode. 

Slika 1.11. Četiri načina generisanja krive radi dobijanja povećane vrednosti 
pokrivenosti tona sa 70% na 80%
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1.3.2.1. Formiranje kontrasta pomoću krive

Formiranje kontrastne slike pomoću krive zahteva određeni oblik krive koji 
će da napravi tonsku razliku između svetlih i tamnih površina. Jedna od 
najjednostavnijih metoda za povećavanje kontrasta je S kriva koja u zavisnosti 
od nagiba može da poveća kontrast neke slike u većoj ili manjoj meri.

S kriva se konstruiše tako što se svetliji tonovi posvetle, a tamniji potamne. 
Kontrolna kriva se u donjem levom kvadrantu savije nadole na polovini 
između 0% i 50%, a sredina krive gornjeg desnog kvadranta između 50 i 
100% se se povuče nagore (više boje), dok je centar manje-više oko 50%. 
Poboljšanje kontrasta je prikazano na slici 1.13.

Slika 1.13. Poboljšanje kontrasta pomoću 
alatke Krive (Curves)

1. Napraviti sloj za podešavanje Krive (Curves) u 
paleti Slojevi (Layers) (Adjustment Layer>Curves)
2. Dodati tačku na krivu u donjem levom kvadrantu 
i povući je nadole

3. Dodati tačku na krivu u gornjem desnom 
kvadrantu i povući je nagore

Prilikom pomeranja krive i definisanja tačaka na njoj treba paziti na željeni 
tonski opseg. Nepravilnim podešavanjem parametara krive se slično kao i 
kod alatke Nivoi (Levels) mogu izgubiti određeni tonovi. Provera gubitaka i 
odsecanja tonova se može kontrolisati isto kao i kod alatke Nivoi (Levels) - 
kontinualnim držanjem dugmeta Alt prilikom rada sa krivom.
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Ukoliko se želi preciznija kontrola korekcije tonova na određenoj 
površini, moguće je tačno definisati poziciju regiona fotografije 
odnosno piksela na krivi.  Odabirom dela slike kapalicom i pritiskom 
na Ctrl dugme uzorkovani ton se pojavljuje u formi kontrolne tačke 
na krivi. Moguće je dodati do 256 tačaka (što se retko čini), a višak 
kontrolnih tačaka je moguće ukloniti držanjem Ctrl dugmeta i 
pritiskom tastera miša na kontrolnu tačku koja se želi ukloniti.

Pošto krive omogućavaju mnogo veću kontrolu od svih ostalih alatki za 
korekciju tonova, korišćenje S krive je često primenjuje kod manjih popravki 
kontrasta slike, kao i kod slika sa sivim tonovima.

Kod slika u boji ili slika sa sivim tonovima gde su različiti regioni neujednačeno 
osvetljeni primenjuje se veći broj kontrolnih tačaka i drugačiji oblici krivih. 
Prilikom rada sa fotografijama u CMYK modelu boja preporučljivo je 
korigovati tonove sa krivima u zasebnim kanalima. Razlog tome je da K kanal 
odnosno crna boja ne učestvuje u mešanju svetline kao hromatski CMY 
kanali. Izbegavanjem rada sa master krivom (koja zbirno podešava tonove u 
svim kanalima) se izbegavaju greške, a pravilnom upotrebom pojedinačnih 
krivih u zasebnim kanalima je moguće postići jači efekat kontrasta kod slika 
u boji.

Na datom primeru (slika 1.14) se može videti da slika sadrži važne zelene 
i žute odnosno narandžaste površine (rastinje i žirafa), dok je pozadina 
(nebo) ujednačena. Primenom klasične S krive se dobija malo poboljšanje 
kontrasta, ali ukoliko se želi istaći kontrast između objekta ili subjekta od 
interesa (žirafe u ovom primeru) i pozadine (zelene krošnje), potrebno je 
napraviti pojedinačne krive koje će tu razliku povećati.

Slika 1.14. Korekcija slike u boji alatkom Krive (Curves)
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Analiza slike kroz kanale ukazuje da se informacije o zelenim površinama 
nalaze u tanijim tonovima u crvenom i plavom kanalu (cijan i žuti kod CMYK 
modela boja). Pomeranjem crvene prema previše tamnim vrednostima, 
zelena bi se pretvorila u plavičastu zelenu umesto očekivane zelene što bi 
ujedno i narušilo balans boja. U crvenom kanalu su svetle vrednosti povećane 
uz premeštanje crne tačke, dok su kod zelenog kanala vrednosti u tamnim 
tonovima blago potamnjene. U plavom kanalu je primenjena S kriva radi 
dobijanja kontrasta za plave i žute tonove. Generalno pravilo je da se odabere 
deo slike gde se želi povećati kontrast i pomeranjem pojedinačnih krivih se 
izvuče maksimum kontrasta sa kontrolama koje pružaju krive.

Slika 1.15. Povećavanje kontrast pomoću pojedinačnih krivih

1. Analizirati informacije u kanalima boje (podešavanja su za 
konkretni primer)

2. Napraviti sloj za podešavanje Krive (Curves) u paleti Slojevi 
(Layers) (Adjustment Layer>Curves)

3. U crvenom kanalu  pomeriti kraj krive sa crne tačke na početak 
koordinatnog sistema gde počinje histogram

4. U zelenom kanalu dodati tačke u srednjim tonovima i tamnim 
tonovima i blago podignuti

5. U plavom kanalu  dodati tačku na krivu u donjem levom 
kvadrantu i povući je nadole, dodati tačku u gornjem desnom 
kvadrantu i povući je blago nagore.
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1.3.4.  Alatka Exsposure

Četvrta alatka u panelu za podešavanje je Ekspozicija (Exposure) koja 
predstavlja jednostavni filter za podešavanje nivoa ekspozicije pomoću tri 
klizača: 

Klizač ■  Ekspozicija (Exposure) koji utiče na svetle tonove bez 
uticaja na tamne tonove slike

Klizač  ■ Izjednačavanje (Offset) koji je namenjen za podešavanje 
srednjih tonova i

Klizač  ■ Gama (Gamma) koji podešava tamne tonove bez 
menjanja svetlih tonova slike.

Ova alatka u kombinaciji sa maskama omogućava ispravljanje pojedinačnih 
delova slike ili uređivanje HDR fotografija.

Na slici 1.16 prikazana je slika slabog kontrasta koji može lako da se ispravi 
alatkom Ekspozicija (Exposure). Na slici 1.17 prikazana je korkecije slike u 
boji pomoću ove alatke pomeranjem tri klizača - Exposure, Offset i Gamma.

Pomoću alatke Krive (Curves) korigovati sledeće fotografije koje su 
priložene uz priručnik:

Slika 1.16 Fotografija sa lošim kontrastom
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Slika 1.17. Korekcija kontrasta i tonova pomoću alatke Ekspozicija (Exposure)

1.4. Načini mešanja slojeva u funkciji korekcija                   
ekspozicije i tonova

Sve prethodno navedene alatke kao što su Nivoi (Levels), Krive (Curves) i 
Ekspozicija (Exsposure) se mogu koristiti direktno na radnom sloju njihovim 
odabirom iz meni linije ili preko direktne skraćenice, ali onda se mora 
računati na nepovratnu promenu izvornih vrednosti piksela.

Drugi način je korišćenje ovih alatki na sloju za podešavanje (Adjustment 
Layer) preko odabira alatke iz panela za podešavanje (Adjustment Panel) ili 
pravljenjem sloja za podešavanje iz podmenija prozora za slojeve (crno-beli 
krug).  Korišćenjem ove metode dobija se nekoliko napomenutih prednosti 
kao što je zaštita izvornih piksela na slici, mogućnost korišćenja maski za 
izolovanje regiona za promenu kao i dodatna opcija za mešanje slojeva.

Načini mešanja slojeva određuju način na koji dolazi do međumešanja tonova 
i boja između slojeva koji se nalaze jedan iznad drugog. Ova međuzavisnost 
je uslovljena vrednostima svetline same slike kao i međuodnosom svetline 
u pojedinačnim kanalima. To omogućava istovremeno i potamnjivanje i 
posvetljivanje pojedinačnih delova slike. Nisu svi postojeći načini mešanja 
slojeva upotrebljivi za korekcije, ali neki od njih mogu da unaprede osvetljenje 
i pojačaju kontrast na slici. 

Photoshop sadrži 25 slojeva za podešavanje koji su podeljeni u šest glavnih 
grupa (tabela 1.1a i 1.1b) u zavisnosti od efekta koji prouzrokuju na slici. U 
okviru ove vežbe će biti obrađeni načini mešanja koji utiču na potamnjivanje, 
posvetljivanje i pojačavanje kontrasta na slici. Još jedna od prednost korišćenja 
načina mešanja slojeva je, naravno, i mogućnost podešavanja jačine efekta 
promenom opaciteta sloja. 
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Tabela 1.1a. Načini mešanja slojeva

Prilikom korišćenja slojeva za podešavanje u funkciji poboljšavanja 
ekspozicije tonova i kontrasta se često koriste „prazni“ slojevi za podešavanje 
odnosno slojevi za Nivoe (Levels), Krive (Curves), ali bez podešavanja njegovih 
osnovnih funkcija. Oni se koriste kao podloga gde do izražaja u ispravljanju 
neodgovarajuće svetline dolazi načinom mešanja nepromenjenog sloja za 
podešavanje i sloja sa izvornim pikselima. 

Najčešće korišćene grupe za korekciju tonova i kontrasta su grupa za 
potamnjivanje, za posvetljivanje i za poboljšavanje kontrasta.

Normal Kombinuje dva sloja na bazi opaciteta. Rezultujuća boja zavisi od 
transparentnosti sloja koji je iznad. 

Dissolve Koristi se veoma retko. Ne dolazi do mešanja vrednosti piksela već se 
nasumično kombinuju vrednosti sa jednog i drugog sloja, a u 
zavisnosti od transparencije.
Ukoliko je opacitet sloja veći, više piksela sa tog sloja će biti na 
rezultujućoj slici i obrnuto.

Grupa za potamnjivanje
(efekat će biti jači, kako boje postaju tamnije)

Darken Upoređuje vrednosti piksela oba sloja i svetlije vrednosti menja 
tamnijima.

Multiply Potamnjuje celu sliku i koristan je kada treba povećati optičku 
gustinu srednjih i svetlih tonova. Veliku primenu nalazi kod
preeksponiranih ili veoma svetlih slika.

Color Burn Potamnjuje sliku i povećava kontrast.

Linear Burn Jaka kombinacija Multiply i Color Burn načina
mešanja; tamne vrednosti forsira do čiste crne.

Grupa za posvetljivanje
(efekat je jači, kako boje postaju svetlije)

Lighten Suprotno od Darken; upoređuje vrednosti piksela oba sloja i tamnije 
vrednosti menja svetlijima.

Screen Posvetljuje celu sliku. Koristan je pri posvetljivanju tamnih partija slike 
i pri korekciji tona kod podeksponiranih slika.

Color Dodge Smanjuje kontrast u područjima svetlijim od 50% sive, zadržavajući 
vrednost crne.

Linear Dodge Kombinacija Screen i Color Dodge načina mešanja; svetle vrednosti 
forsira do čiste bele.
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Soft Light Kombinacija Dodge načina mešanja, koji posvetljiva svetle vrednosti, 
i Burn-a koji potamnjuje tamne. Manje pojačava kontrast nego Over-
lay ili Hard Light.

Hard Light Potamnjuje tamne tonove i posvetljuje svetle i
dramatično povećava kontrast (više nego Overlay).

Vivid Light Posvetljava vrednosti piksela iznad 50% sive smanjivanjem kontrasta 
i potamnjuje vrednosti ispod 50% sive povećavanjem kontrasta.

Linear Light Kombinuje Linear Burn i Linear Dodge; povećavanjem svetline 
posvetljuje vrednosti iznad 50% sive, dok vrednosti ispod 50% sive 
potamnjuje smanjivanjem svetline.

Pin Light Kombinuje Darken i Lighten da zameni vrednost piksela. Korišćenjem 
ove opcije postiže se jak kontrast, pa se koristi za specijalne efekte i, 
ređe, za kreiranje maski.

Hard Mix Posvetljava svetle i potamnjuje tamne vrednosti do tačke praga i 
ekstremne posterizacije.

Komparativni načini mešanja

Difference Identične vrednosti piksela tretira kao crne, slične kao tamne, a 
različite vrednosti bivaju invertovane. Rezultujuća boja po svakom 
kanalu je apsolutna razlika vrednosti piksela donjeg i sloja koji je 
iznad.

Exclusion Sličan kao Difference, ali sa manje kontrasta. Mešanje sa crnom 
ne dovodi do promena, dok mešanje sa belom dovodi do toga da 
poređena vrednost bude tretirana kao siva.

Kompozitni načini mešanja

Hue Kombinuje svetlinu i zasićenje sloja koji se nalazi
ispod sa tonom gornjeg sloja.

Saturation Kombinuje svetlinu i ton sloja koji se nalazi ispod sa zasićenjem 
aktivnog sloja.

Color Zadržava boju aktivnog sloja i svetlinu sloja koji se nalazi ispod.

Luminosity Suprotan od Color jer zadržava svetlinu aktivnog sloja zajedno sa 
bojom drugog sloja.

Grupa za poboljšanje kontrasta
(koriste se da pojačaju kontrast slike)

Overlay Umnožava vrednosti tamnih tonova i posvetljava svetle tonove bez 
forsiranja do čiste crne i bele, što povećava kontrast bez gubitka 
tonova.

Tabela 1.1b. Načini mešanja slojeva
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Grupa za potamnjivanje stvara efekat potamnjivanja preko cele slike. 
Karakteristika ove grupe je da bela boja sa digitalnom vrednošću od 255 
na aktivnom sloju nema efekat na sliku koja se nalazi na sloju ispod sloja za 
podešavanje i predstavlja neutralnu boju. Prilikom korišćenja praznog sloja 
za podešavanje sa Multiply načinom mešanja se dobijaju dobri rezultati u 
pogledu kontrasta i rasporeda tonova. Darken i Darker Color nemaju efekta 
sa praznim slojem za podešavanje, dok Color Burn i Linear Burn izazivaju 
odsecanje tamnih tonova i prezasićene boje kod slika u boji. 

Multiply potamnjuje celu sliku upoređujući piksele osnovnog sloja sa slikom 
i piksele sloja za podešavanje i udvostručuje vrednosti osnovne boje na 
fotografiji sa bojom na sloju za podešavanje. Umnožavanje sa crnom uvek će 
dati crnu, dok kao što je napomenuto, bela nema nikakav uticaj na promenu. 
Nije važno da li je sloj za podešavanje tamniji odnosno svetliji od osnovne 
boje, rezultat je uvek tamnija podloga. U fotografskom smislu ova operacija 
predstavlja smanjenje ekspozicije za tri koraka svetlosne jačine (f stop) ili 
vizuelno odgovara postavljanju dva slajda jedan iznad drugog.

Korišćenje slojeva za podešavanje i variranjem opaciteta Multiply se može 
koristiti za dodavanje optičke gustine svetlim tonovima i srednjim tonovima 
naročito kod slika koje su preeksponirane. Na sledeća dva primera (slika u 
sivim tonovima i slika u boji-obe podeksponirane) je prikazana mogućnost 
korekcije ekspozicije i dobijanja dodatnih tonova za reprodukciju. Kod oba 
tipa slike je postupak sličan:

Napravi se prazan sloj za podešavanje ■
Namesti se  ■ Multiply kao način mešanja slojeva
Prilagodi se opacitet sloja ■
Po potrebi dvostrukim vom otvori se sloj za podešavanje  ■

Nivoi (Levels) i ukoliko je potrebno, izvrše se dodatne ispravke 
pomeranjem klizača alatke Nivoi (Levels)

Slika 1.18. Pojačavanje optičke gustine načinom mešanja  Multiply od 50%
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Slika 1.19.  Pojačavanje optičke gustine načinom mešanja Multiply od 50%

Oba primera su bila napravljena sa praznim slojevima za podešavanje 
(Nivoi (Levels) i Krive (Curves)) i sa različitim vrednostima opaciteta. Kod 
klizača je važno napomenuti da gornji klizač sa oznakom Opacity kontroliše 
providnost sloja odnosno prodvidnost svih načina mešanja ili stilova sloja. 
Donji klizač je za kontrolu providnosti punjenja (Fill Opacity), ima uticaj 
samo na pikselima koji su na sloju bez efekta na opacitet bilo kojeg efekta 
sloja.

Na slici 1.19 prikazana je korekcija slike koja je podeksponirana. Na slici 
desno se vidi kako je moguće popraviti ekspoziciju i dodati tonove za 
reprodukciju odabirom načina mešanja sloja Multiply. Vrednost opaciteta 
postavljena je na 20%, kako ne bi bio jak intenzitet ispravljanja.

1. Napraviti sloj za podešavanje Krive (Curves) u paleti 
Slojevi (Layers) ili Nivoi (Levels) (Adjustment Layer>Curves 
ili Levels)

2. Podesiti način mešanja sloja za podešavanje na Blending 
mode>Multiply

3. Prilagoditi vrednost providnosti (Opacity)
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Slika 1.20. Korekcija podekspozicije (slika u sivim tonovima i slika u boji) 
Screen načinom mešanja

Treća grupa načina mešanja slojeva sadrži načine za posvetljivanje sadržaja 
i počinje načinom Lighten koji će načiniti sloj svetlijim nego kod izvorne 
slike. Neutralna boja kod ovog načina mešanja je crna, što znači da ona neće 
imati efekat na sloj koji se nalazi ispod sloja sa uključenim mešanjem za 
posvetljivanje. Prilikom korišćenja ovih načina mešanja u kombinaciji sa 
praznim slojevima najoptimalniji je Screen. Lighten i Lighter Color nemaju 
efekta kada se koriste prazni slojevi za podešavanje, dok će Linear Dodge 
prouzrokovati odsecanje svetlih tonova. Screen je obrnuta funkcija od 
Multiply i uzrokuje višestruko posvetljivanje cele slike za tri svetlosne jačine 
(f stop). Korišćenje ovog načina mešanja slojeva je pogodno za otvaranje 
tamnih tonova na slici i izvlačenje detalja iz podeksponiranih delova slike. 
Primer upotrebe je dat na sledećim primerima (slika 1.20), dok je postupak 
primene isti kao i kod načina za potamnjivanje.

1. Napraviti sloj za podešavanje Krive (Curves) u paleti Slojevi 
(Layers) ili Nivoi (Levels) (Adjustment Layer>Curves ili Levels)

2. Podesiti način mešanja sloja za podešavanje na Blending 
mode>Screen

3. Prilagoditi vrednost providnosti (Opacity)
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Slika 1.21. Fotografija sa lošim kontrastom

Četvrta grupa načina za mešanje slojeva predstavlja grupu za popravku 
kontrasta. Fotografija prikazan na slici 1.21 je izbledela i nema dovoljno 
dobar kontrast, tamni tonovi nisu dovoljno tamni, a svetli nisu dovoljno 
svetli. Da bi se slika popravila, potrebno je izabrati jedna od načina mešanja 
slojeva iz ove grupe.

Četvrta grupa počinje sa Overlay i povećava kontrast na slici posvetljivanjem 
svetlih tonova i potamnjivanjem tamnih tonova. Postoji sedam načina 
mešanja gde su Overlay, Soft Light i Hard Light najpogodiniji za izmenu 
fotografija. Neutralna boja, tj. ona koja nema efekta prilikom mešanja slojeva, 
je 50% sive. Tonovi koji su tamniji od 50% sive daju tamnije rezultate, dok 
vrednosti svetlije od 50% daju svetlije digitalne vrednosti. Najjači kontrast se 
postiže korišćenjem načina mešanja Hard Light zatim Soft Light, dok Overlay 
predstavlja kombinaciju ove dve metode. Na datom primeru je urađena 
ispravka kontrasta pomoću načina mešanja Overlay koji je postavljen na 
novi prazan sloj za podešavanje Nivoi (Levels) (slika 1.22).

Slika 1.22. Povećavanje kontrasta načinom mešanja Overlay i
dodatnim pomeranjem klizača za srednje tonove
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Slika 1.23. Povećavanje kontrasta načinom mešanja Overlay i
dodatnim pomeranjem klizača za srednje tonove 

Slojevi za podešavanje i načini mešanja slojeva se mogu koristiti i za 
ispravljanje neujednačeno osvetljenih slika. Popravljanje kontrasta i 
osvetljenja osvetljenog dela slike se postiže upotrebom maski. Na primeru 

Na slici 1.23 prikazan je još jedan primer sa lošim kontrastom i njegova 
korekcija pomoću načina mešanja Overlay koji je postavljen na novi prazan 
sloj za podešavanje Nivoi (Levels).

Korišćenje načina mešanja slojeva nije zamena za rad sa krivima i 
nivoima i drugim naprednim alatkama za korekciju tonova i kontrasta, 
nego korisni dodatak koji omogućuje lakši početak korekcije neke 
pod ili preeksponirane slike.

1. Napraviti sloj za podešavanje Krive (Curves) u 
paleti Slojevi (Layers) ili Nivoi (Levels) (Adjustment 
Layer>Curves ili Levels)

2. Podesiti način mešanja sloja za podešavanje na 
Blending mode>Overlay radi boljeg kontrasta

3. Prilagoditi vrednost providnosti (Opacity)

4. Pomeriti klizač na sloju za podešavanje radi 
preciznijeg podešavanja
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Slika 1.24. Korekcija slike načinom mešanja slojeva Multiply i 
korišćenjem maske sa tonskim prelazima

Pomoću jednog od načina mešanja slojeva korigovati sledeće fotografije 
koje su priložene uz priručnik. Prvu sliku je potrebno potamniti, drugu 
posvetliti i na trećoj popraviti kontrast:

(slika 1.24) se može videti da je slika neravnomerno osvetljena, to jest da je 
leva strana tamnija, a desna svetlija. Primena neke od opcija za potamnjivanje 
kao što je Multiply bi zatamnila celu sliku i time  ugrozila tamne tonove na 
desnoj strani. Primenom maske (gde je crnom bojom zaštićena desna strana 
slike) je tonskim prelivom postignuta zaštita već dovoljno tamnih površina i 
dobija se efekat ujednačavanja osvetljenih površina.

1. Napraviti sloj za podešavanje Krive (Curves) u paleti Slojevi 
(Layers) ili Nivoi (Levels) (Adjustment Layer>Curves ili Levels)

2. Napraviti masku na sloju za podešavanje i napraviti tonski preliv 
od crne do bele boje (crna je na desnoj strani, bela na levoj strani)

3. Podesiti način mešanja sloja za podešavanje na Blending 
mode>Multiply radi boljeg kontrasta

4. Prilagoditi vrednost providnosti (Opacity)
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Slika 1.25. Pretvaranje sloja u Pametan objekat (Smart Object) i izgled prozora 
opcije Senke/Svetli tonovi (Shadows/Hightlights)

1.5. Opcija Shadows/Highlights

Korekciju tonova i raspona svetline je moguće uraditi i preko filtera Senke/
Svetli tonovi (Shadows/Highlight) koji se koristi za naprednu korekciju 
tonova pomoću predefinisanih algoritama. Ova alatka se može koristiti za 
posvetljivanje tamnih tonova ili potamnjivanje veoma svetlih tonova bez 
uticaja na druge delove slika. Odabirom tonskog opsega za posvetljivanje 
i potamnjivanje, ova komanda analizira  susedne piksele oko odabranog 
dela slike i određuje srednju vrednost svetline piksela za dati opseg odnosno 
radijus. Filter Senke/Svetli tonovi (Shadows/Highlight) je dobar odabir 
kada postoje upotrebljivi podaci u tamnim ili svetlim tonovima, ali tonska 
kompresija ne omogućava njihov prikaz.

Kod rada sa ovim filterom se ide na osećaj i ne postoje predefinisane vrednosti, 
a jedna od stvari na koje treba paziti je da se posvetljivanjem tamnih površina 
ne prikazuje previše šuma na slici ukoliko je prisutan. Još jedna od prednosti 
ove alatke je mogućnost upotrebe kao Pametnog filtera (Smart Filter) čime se 
izbegava neželjena promena izvornih piksela koja bi se dogodila direktnim 
pristupom ovom filteru (Image>Adjustments>Shadows/Highlights). Da bi se 
filter aktivirao kao pametni filter, potrebno je sloj pretvoriti u Pametni objekat 
(Smart Object) odabirom podmenija palete slojeva i nakon toga pristupiti 
filteru Senke/Svetli tonovi (Shadows/Highlights) preko meni linije. Na slici 
1.25a prikazan je postupak pretvaranja sloja u pametan objekat, a na slici 
1.25b kako se pametan filter prikazuje u paleti Slojevi (Layers). Na slici 1.25b 
je prikazan radni prozor filtera Senke/Svetli tonovi (Shadows/Highlights).
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Bilo koji filter (sem filtera Extract, Liquify, Pattern Maker, Vanishing Point)  
i alatke Shadows/Highlights i Variations, primenjeni na pametan objekat 
postaju pametan filter. Prednost ovog filtera je u tome što se može naknadno 
podešavati, maskirati, obrisati ili sakriti, a da se ne utiče na izvorne piksele. 

Osnovne komande alatke Senke/Svetli tonovi (Shadows/Highlights) su:

Količina (Amount) kontroliše u kojoj meri je odabrani tonski opseg osvetljen 
(tamni tonovi) ili potamnjen (svetli tonovi). Pomeranje klizača od prethodno 
definisanih 50% određuje željenu svetlinu tih tonskih regiona.

Tonski opseg (Tonal Width) upravlja nizom tonova koji će biti promenjeni 
sa definisanom količinom. Niža vrednost definiše da će samo najtamniji 
odnosno najsvetliji tonovi biti promenjeni, dok će povećavanje vrednosti 
proširiti ove promene na širi deo tonskog opsega.

Poluprečnik (Radius) određuje tamne i svetle delove slike analizirajući svaki 
piksel i njegove susedne piksele. Radius određuje veličinu okoline koja se 
uzorkuje kada se piksel odredi kao tamni odnosno svetli piksel i kako da 
se efekat uklopi prema vrednostima količine (Amount) u okolne delove 
slike. Niske vrednosti mogu prouzrokovati ravne niskokontrastne rezultate, 
dok će veoma visoke vrednosti imati jako prošireni efekat koji će izlaziti iz 
definisanih tamnih i svetlih delova slike.

Korekcija boja (Color Correction) nije klasična alatka za korekciju boja, nego 
omogućava smanjivanja zasićenja u promenjenim tonskim opsezima koji se 
mogu prouzrokovati upotrebom ovog filtera. Negativne vrednosti smanjuju 
zasićenost, dok pozitivne povećavaju zasićenost. Ukoliko se posvetljuje 
tamna podeskponirana površina, ova opcija može da pomogne prilikom 
dodavanja zasićenja nekim površinama koje su podeksponirane.

Kontrast srednjih tonova (Midtone Contrast) omogućava kontrolisanje 
piksela odnosno kontrasta u srednjem tonskom opsegu, pošto je nekada 
potrebno popraviti kontrast i u tim tonovima (slično kao kod sivog klizača 
alatke Levels, mada se za napredne korekcije ipak preporučuje zaseban sloj 
sa krivima.

Odsecanje crnih i belih tonova (Black Clip i White Clip) su vrednosti odesecanja 
koje će staviti delove najtamnijih i najsvetlijih piksela u delove čisto crnih i 
čisto belih povšina i time sprečiti da se promene prilikom promene vrednosti 
definisane količinom i poluprečnikom. Najčešće se ove vrednosti ostavljaju 
na predefinisane (0.01%), ali promena ovih vrednosti ponekad može da 
pomogne kod specifičnih površina kao što su spekularne visoke reflektivne 
površine (refleksija sa stakala, vode ili drugih visokosjajnih površina). 
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1.6. Alatke Dodge Tool i Burn Tool

U klasičnoj reprodukcionoj tehnici potamnjivanje odnosno posvetljivanje 
određenih površina se radilo određenim hemijskim postupcima odnosno 
maskiranjem i ponovnim osvetljavanjem. Digitalne tehnike za specifično 
ručno podešavanje potamnjivanja i  posvetljivanja u Photoshopu pružaju 
određene mogućnosti, kako za korekciju nepravilne ekspozicije, tako i 
za kreativno unapređivanje samih fotografija u smislu tonskog opsega i 
kontrasta. Alatka za potamnjivanje (Burn Tool) i alatka za posvetljivanje    
(Dodge Tool) su standardne alatke u Photoshopu koje smanjuju odnosno 
povećavaju svetlinu piksela na slici. Direktna upotreba uništava izvorne 
piksele, ali njihova upotreba na slojevima za podešavanje ili neutralnim 
slojevima omogućava precizno ručno dorađivanje ekspozicije u specifičnim 
delovima slike bez oštećenja izvornih piksela.

Na sledećem primeru (slika 1.26) je data korekcija pomoću filtera Senke/
Svetli tonovi (Shadows/Highlight) sa prethodno definsanim podešavanjima 
i podešavanjima od 50% za svetle i tonove kod opcije Amount i prethodno 
definisanim vrednostima za ostale veličine ili opcije.

Slika 1.26. Korekcija slike opcijom Senke/Svetli tonovi (Shadows/Highlights)

1. Pretvoriti  osnovni sloj slike u pametni objekat u 
podmeniju palete Slojevi (Layers) (Convert to Smart 
Object)

2. Pristupiti alatki Senke/Svetli tonovi (Shadow/
Highlight) (Image>Adjustments>Shadow/Highlight)

3. Podesiti klizačima vrednosti za svetle i tamne 
tonove
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Slika 1.27. Dodavanje novog sloja koji je popunjen neutralnom sivom (50%),
način mešanja sloja postavlja se na Overlay

Upotreba Neutralnog sloja (Neutral Fill Layer) omogućava mnoge napredne 
tehnike s obzirom na to da mnogi načini mešanja slojeva ne utiču na 
crnu, belu ili 50% sive boje. Kada je sloj koji je mešan Overlay ili Soft Light 
načinom mešanja za povećavanje kontrasta popunjen sa 50% sive boje, 
promena svetline će uticati samo na piksele koji su svetliji odnosno tamniji 
od 50% sive. Time se omogućava korišćenje Dodge i Burn alatke na istom 
sloju. Ukoliko se koristi Overlay, dobija se i dodatni kontrast na slici. Soft 
Light će dati blaži efekat sa manjim povećanjem kontrasta pored ručnog 
podešavanja zatamnjivanja i posvetljivanja. Na primeru prikazanom na slici 
1.28 je prikazan ovaj postupak korekcije tonova i kontrasta. Iznad slike treba 
postaviti novi sloj i popuniti ga sa 50% sive Layer>New Layer i odabrati 
opciju mešanja Overlay i za popunjavanje sa 50% neutralne sive (Fill with 
Overlay neutral color 50% gray).

Na izvornoj fotografiji (slika 1.28a) je prikazan čovek ogrnut zastavom koji 
ima nižu vrednost optičkog zacrnjenja u odnosu na gospođe na desnoj strani 
slike. Da bi se slika tonski ujednačila, na levoj strani slike treba povećati, a na 
središnjoj i desnoj strani smanjiti optičko zacrnjenje. Pre rada na neutralnom 
sloju treba odabrati četkicu određene veličine i jačine i podesiti tonski opseg 
za popravljanje. U prikazanom primeru je rađeno sa srednjim tonovima 
i Jačinom četkice (Exposure) od 50%. Na sivom sloju leva strana slike je 
popravljena alatkom Burn, dok je smanjivanje optičke gustine na drugom 
delu slike postignuto alatkom Dodge.

Slika 1.28. Slika (a) pre i (b) posle ručnog popravljanja ekspozicije i kontrasta
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Slika 1.29. Neutralni sloj sa potamnjenim i posvetljenim delovima

Pomoću filtera Senke/Svetli tonovi (Shadows/Highlights) i  alatki Dodge i 
Burn korigovati sledeće fotografije koje su priložene uz priručnik:

Na slici 1.29 je prikazan i neutralni sloj za popravku gde su crne površine 
dobijene alatkom Burn, a bele alatkom Dodge. Površine koje su sive nisu 
promenjene.

1. Dodati novi prazan sloj iznad osnovnog sloja sa Layer>New 
Layer (Shift+Ctrl+N)

2. U podešavanjima namestiti način mešanja na  Overlay 
(Blending mode>Overlay)

3. Odabrati opciju Fill with Overlay neutral color 50% gray

4. Alatkom Burn na sloju sa 50% sive potamniti površine koje 
imaju nisku optičku gustinu

5. Alatkom Dodge na sloju sa 50% sive posvetliti površine 
koje imaju previsoku optičku gustinu
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Korekcija tonova i kontrasta se koristi radi dobijanja punog tonskog  ■
opsega reprodukcije kao i za izbegavanja određenih tonova koji se ne 
mogu reprodukovati određenom tehnikom štampe.

Histogram predstavlja brzi pregled rasporeda tonova. Ako je histogram  ■
uglavnom nagnut na desnu stranu, slika je svetlija, ako je dominantni broj 
piksela u levom delu histograma, slika je tamnija.

Ne postoji idealan oblik histograma, ali histogram postavljen u sredini  ■
može ukazivati na loš kontrast.

Koristiti metode za korekciju koja ne oštećuju izvorne piksele kao što  ■
su slojevi za podešavanje.

Neogdovarajuća podešavanja mogu da prouzrokuju gubitak određenih  ■
tonova, što dovodi do posterizacije u štampi. Histogram sa velikim brojem 
pojedinačnih linija ukazuje na takvu pojavu.

Kontrast se najčešće pojačava definisanjem nove crne i bele tačke. ■
Kod podešavanja najsvetlije i najtamnije tačke kod svih alatki paziti na  ■

odsecanje tonova.
Početni nagib krive za korekcije je 45 stepeni. Povećavanjem nagiba se  ■

postiže povećavanje kontrasta, snižavanjem smanjivanje kontrasta.
Kod slika u sivim tonovima najčešće se koristi S kriva za kontrast, slike  ■

u boji zahtevaju podešavanje u pojedinačnim kanalima.
Načini mešanja slojeva u kombinaciji sa osnovnim alatkama za  ■

korekciju mogu pomoći pri povećavanju optičke gustine i kontrasta slike.
Za delimične korekcije tonova i kontrasta se mogu koristiti maske i  ■

neutralni slojevi sa ručnim potamnjivanjem i posvetljivanjem.






